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Guida manuale MetaTrader 5

MetaTrader 5 è una delle piattaforme di trading più popolari. I trader la usano per 
accedere ai mercati forex, azioni e futures. MT5 è uno strumento di trading universale 
che fornisce le funzionalità necessarie per il trading di successo. La piattaforma 
consente agli utenti di condurre l'analisi tecnica e fondamentale, dispone di trading 
automatizzato e può essere lanciata su dispositivi mobili.

MetaTrader 5 in cifre:


�

� 9 tipi di ordini�
� 82 strumenti analitici tra cui indicatori tecnici e oggetti grafici�
� 21 timeframe�
� fino a 100 grafici aperti contemporaneamente


Utilizzando la piattaforma MT5, potrai usufruire di asset forniti da InstaForex che 
includono quasi 3.000 strumenti: valute fiat, azioni statunitensi ed europee, indici, 
materie prime, criptovalute, ETF e SPAC.

Il nostro manuale copre i seguenti argomenti:

�� Come iniziare �
�� Nozioni di base�
�� Strumenti di trading�
�� Come impostare gli ordini
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�� Come iniziare 

Prima di tutto, installa MT5 sul tuo computer o dispositivo mobile. Puoi scaricare il file 
di installazione con un clic su . Fai clic su Piattaforma di trading (Trading 
Platform) nel menu in alto e seleziona MetaTrader 5. Quindi, scegli semplicemente il 
sistema operativo del tuo dispositivo.
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MT5 ha un'interfaccia semplice e intuitiva. Tutte le funzioni necessarie si trovano nel 
menu principale. La barra degli strumenti contiene le funzioni più utilizzate che puoi 
personalizzare. Per farlo, fai clic con il tasto destro del mouse sulla barra degli 
strumenti e seleziona Personalizza (Customize).

La finestra Market Watch a sinistra mostra le quotazioni di tutti gli strumenti di 
trading disponibili mentre la finestra Navigatore (Navigator) consente di gestire gli 
strumenti di trading per l'analisi tecnica. La finestra Toolbox in basso mostra le 
informazioni di un conto di trading, statistiche di trading, notizie di mercato, 
cronologia e altri dati importanti.





Per comodità degli utenti, tutti gli elementi dell'interfaccia MT5 sono completamente 
personalizzabili. Pertanto, puoi nascondere qualsiasi finestra se necessario e 
concentrarti, ad esempio su Market Depth.


L'interfaccia della piattaforma
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Quando avvii la piattaforma per la prima volta, ti spunterà una finestra pop-up in cui 
puoi aprire un nuovo conto o accedere a quello esistente. InstaFintech Ltd. è 
impostato come predefinito, quindi fai clic su Avanti (Next) per continuare.

Un altro modo per accedere è fare clic su File-> Accedi al conto di trading (Login to 
Trade Account). Nella finestra pop-up, inserisci il numero del conto e la password e fai 
clic su OK.

Come accedere
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Ordini, operazioni e posizioni sono correlati. Ad esempio, decidi di andare long su 
EUR/USD, cioè vuoi comprare. In questo caso, devi aprire una posizione lunga 
inviando un ordine pertinente al tuo broker. Successivamente, decidi di aumentare il 
volume della posizione aperta, in modo da aprire un'operazione con conseguente 
maggiore volume della tua posizione. 

MT5 supporta i sistemi di contabilità Copertura (Hedging) e Compensazione 
(Netting). Quando viene applicato il sistema Netting, hai una posizione comune per un 
simbolo. Ad esempio, se hai una posizione di acquisto su EUR/USD ma decidi di 
aprire un'operazione di vendita, il volume totale della tua posizione esistente verrà 
ridotto. Il sistema Hedging consente di aprire più posizioni su un simbolo, comprese 
le posizioni opposte. La scelta del sistema dipende dalla tua strategia di trading.

Sistema di contabilità delle posizioni

MT5 supporta il mercato e gli ordini pendenti. Quando invii un ordine di mercato a un 
broker, la tua operazione viene eseguita subito dopo la ricezione di questo ordine. Un 
ordine pendente viene eseguito quando vengono soddisfatte determinate condizioni. 
Sono disponibili i seguenti tipi di ordini pendenti:

Tipi di ordini

Prima di iniziare a fare trading, devi imparare alcune nozioni che ti aiuteranno a 
condurre in modo efficiente le tue operazioni di trading:

� L'ordine è un'istruzione al tuo broker di aprire un'operazione (buy o sell). Ci sono 
ordini di mercato che vengono eseguiti subito e ordini pendenti che vengono 
eseguiti quando vengono soddisfatte determinate condizioni.�

� L'operazione è un'operazione finanziaria di acquisto o vendita di uno strumento di 
trading.�

� La posizione riflette il numero totale di contratti acquistati o venduti.

2. Nozioni di base

� Buy Limit - un ordine di acquisto al prezzo Ask uguale o inferiore a quello 
specificato nell'ordine�

� Buy Stop - un ordine di acquisto al prezzo Ask uguale o superiore a quello 
specificato nell'ordine�

� Sell Limit - un ordine di vendita al prezzo Bid uguale o superiore a quello 
specificato nell'ordine
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Il tuo ordine può essere in uno dei seguenti stati:

Le informazioni su tutti gli ordini eseguiti sono disponibili nella scheda Cronologia 
(History) della finestra Toolbox. Per visualizzare lo stato degli ordini pendenti, vai alla 
scheda Operazioni (Trade). 

� Aperto (Started) — l'ordine è stato impostato, ma il rivenditore non l'ha ancora 
accettato�

� Impostato (Placed) — l'ordine è stato accettato dal rivenditore�
� Eseguito parzialmente (Partially filled)  — l'ordine è stato eseguito parzialmente�
� Eseguito (Filled) — l'ordine è stato eseguito per intero volume completo�
� Annullato (Canceled) — l'ordine è stato annullato dal cliente�
� Rifiutato (Rejected) — l'ordine è stato rifiutato dal rivenditore�
� Scaduto (Expired) — l'ordine è scaduto


Lo stato degli ordini

Ci sono anche ordini Stop Loss e Take Profit. Il primo ha lo scopo di ridurre le perdite 
e viene attivato per chiudere completamente una posizione appena il prezzo 
raggiunge un livello preimpostato. L'ordine Take Profit funziona allo stesso modo, ma 
viene utilizzato per fissare il profitto. 

� Sell ​​Stop - un ordine di vendita al prezzo Bid uguale o inferiore a quello specificato 
nell'ordine�

� Buy Stop Limit - una combinazione di ordini Buy Limit e Buy Stop. È sviluppato per 
impostare un ordine Buy Limit non appena il prezzo Ask raggiunge un livello 
predeterminato�

� Sell ​​Stop Limit - un ordine per impostare un Sell Limit non appena il prezzo Bid 
raggiunge un livello predeterminato
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3. Strumenti di trading

La finestra Profondità di mercato 
(Depth of Market, DOM) mostra il 
saldo corrente dei prezzi BID e ASK. 
Per aprire la DOM, clicca con il tasto 
destro su uno strumento di trading 
necessario nella finestra Market 
Watch e seleziona Profondità di 
mercato (Depth of Market). Un altro 
modo è quello di premere Alt+B. È 
possibile acquistare o vendere uno 
strumento cliccando l'apposito 
pulsante.

Profondità di mercato

(Depth of Market)

Nella MT5 è possibile utilizzare il trading algoritmico, i.e. installare un consulente 
esperto che è il software che apre e chiude automaticamente le operazioni 
utilizzando un algoritmo speciale. Sulla MT5 ci sono consulenti integrati disponibili 
come ExpertMACD o ExpertMAMA, oppure è possibile importare i consulenti esterni.

Consulenti esperti (Expert Advisors)

Avvertenza sui rischi: Il trading algoritmico comporta un elevato rischio di 
perdite. Si consiglia di utilizzare consulenti esperti solo da una fonte attendibile. 
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Per abilitare il trading algoritmico, fai clic sul pulsante Algo Trading nel menu in alto. 

Per gestire il funzionamento dei consulenti esperti, vai su Strumenti (Tools) -> Opzioni 
(Options) e apri la scheda Consulenti Esperti (Expert Advisors).
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La finestra Market Watch mostra le quotazioni, le statistiche dei prezzi e i grafici tick. 
Per aggiungere/eliminare simboli, apri la finestra di configurazione cliccando con il 
tasto destro su qualsiasi simbolo. Nella finestra pop-up, seleziona i simboli che 
desideri aggiungere all'elenco Market Watch e fai clic su Mostra Simbolo (Show 
Symbol).

Market Watch

Se fai doppio clic su un simbolo, lancerai una 
finestra per aprire una nuova posizione. Per aprire 
un grafico a simboli, trascinalo e rilascialo 
nell'area di visualizzazione del grafico. Se si tiene 
premuto Ctrl durante il trascinamento, verrà 
aperto un grafico in una nuova finestra. È 
possibile aggiungere nuove colonne nella finestra 
di configurazione. È possibile filtrare i simboli 
facendo clic sulla colonna corrispondente. 





Per visualizzare le statistiche su un particolare 
simbolo, selezionalo e apri la scheda Dettagli 
(Details).
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È possibile aprire un'operazione con un solo 
clic nella scheda Trading della finestra Market 
Watch.

Trading con un clic

Tuttavia, è possibile utilizzare questa funzione solo se la si attiva nella finestra 
Opzioni (Options). Nel menu in alto, fai clic su Strumenti (Tools)->Opzioni (Options). 

Importante! Prima di spuntare la casella, si prega di leggere attentamente il disclaimer.
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Sia gli indicatori che i consulenti esperti possono essere trovati nella finestra 
Navigatore (Navigator). Per comodità, gli indicatori tecnici sono divisi in gruppi. Per 
avviare un indicatore, puoi semplicemente trascinarlo dalla finestra Navigatore 
(Navigator) e rilasciarlo sul grafico necessario. Facendo questo, apparirà una finestra 
di configurazione:

Importante: si prega di assicurarsi di importare software da una fonte attendibile. 

MetaTrader 5 ha 38 indicatori tecnici integrati e 4 consulenti esperti. Inoltre, non c'è 
alcun limite su indicatori personalizzati o consulenti esperti. 

Come aggiungere un indicatore o un consulente 
esperto a un grafico

Qui è possibile impostare i 
parametri necessari come 
periodo, colore, livelli, 
scala, ecc.

Come aggiungere un consulente esperto a un grafico: trascinarlo e rilasciarlo o fare 
clic destro e selezionare Allega al grafico (Attach to Chart). È importante sottolineare 
che MT5 dispone di una funzione di test, in modo da poter controllare il 
funzionamento di un consulente esperto prima di metterlo in azione. Per eseguire la 
finestra Strategy Tester, fai clic con il tasto destro su Consulente Esperto (EA) e 
seleziona Prova (Test). 

Per abilitare il funzionamento di consulenti esperti, fai clic sul pulsante Algo Trading nel 
menu della barra degli strumenti.
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Come già accennato, MT5 supporta il mercato e gli ordini pendenti. Pertanto, per aprire una 
posizione, ovvero acquistare o vendere un determinato importo di uno strumento di trading, 
puoi impostare un ordine di mercato in modo che la tua operazione venga eseguita 
immediatamente. Se imposti un ordine pendente, una posizione verrà aperta dopo 
l'attivazione dell'ordine. 



Esistono diversi modi per aprire una finestra di dialogo per impostare un ordine:


Upon performing any of these actions, you will see the following window:

� Simbolo (Symbol): lo strumento di trading che intendi acquistare o vendere�
� Tipo (Type): il tipo di esecuzione dell'ordine (di mercato o pendente)�
� Volume: l'importo di uno strumento di trading che desideri acquistare o vendere, espresso 

in lotti. Il volume minimo di InstaForex è 0,01 lotto. �
� Stop Loss/Take Profit: i livelli di prezzo in cui desideri che vengano attivati ​​gli ordini Stop 

Loss o Take Profit. Puoi lasciare questi campi vuoti se non vuoi impostare ne S/L ne T/P.�
� Commento (Comment): qualsiasi commento sulla tua posizione con massimo 31 

caratteri. Il commento apparirà nell'elenco delle posizioni aperte e nella cronologia delle 
negoziazioni. Questo campo è facoltativo. 


� Fare clic con il tasto destro del mouse su un simbolo nella finestra Market Watch e 
selezionare Nuovo ordine (New Order).�

� Fare clic su Nuovo ordine (New Order) nella barra degli strumenti Standard o 
selezionare Strumenti (Tools)-> Nuovo ordine (New Order).�

� Premere il tasto di scelta rapida F9.


4. Come impostare gli ordini

In questa finestra è possibile impostare i parametri dell'ordine:

Dopo aver impostato i parametri di cui sopra, fai clic sul pulsante Vendi (Sell) o Acquista 
(Buy). Quello che vedrai dopo è la finestra che conferma il tuo ordine o specifica il motivo per 
cui non è stato eseguito. 
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Dopo aver aperto una posizione, è necessario osservarne l'andamento e tenerla sotto 
controllo. L'elenco delle posizioni attualmente aperte può essere visualizzato nella 
scheda Trading della finestra Toolbox.

Questa scheda fornisce informazioni sullo strumento di trading, tipo, volume, prezzo, 
livelli attuali di T/L e S/L (se presenti) e profitto. Inoltre, qui vengono mostrati il ​​saldo 
attuale e il risultato cumulativo di tutte le posizioni aperte.



La scheda Esposizione (Exposure) mostra un'analisi dettagliata di tutte le posizioni 
aperte e lo stato del conto.


Per modificare o eliminare la tua posizione, fai clic con il tasto destro del mouse sulla 
scheda Operazioni (Trade) e seleziona Modifica o Elimina (Modify or delete). Nella 
finestra pop-up è possibile impostare nuovi livelli di T/P e S/L o modificare quelli 
esistenti. 

Gestire le tue posizioni
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Si noti che il pulsante Modifica (Modify) è attivo solo se i livelli di Stop Loss e Take 
Profit sono impostati correttamente. 

Per chiudere una posizione, fai doppio clic. Puoi chiudere la tua posizione a pieno 
volume o solo in parte selezionando il volume rilevante.



Se selezioni Chiudi (Close) nel menu contestuale della posizione, questa verrà chiusa 
a pieno volume in una volta. 

Come già sai, lo Stop Loss ha lo scopo di ridurre al minimo le perdite. Si attiva se il 
prezzo va nella direzione sbagliata e chiude la tua posizione a un livello prestabilito. 
Se la posizione diventa redditizia, lo Stop Loss dovrebbe essere spostato a un punto 
di pareggio. Il Trailing Stop lo fa automaticamente. Sposta lo Stop Loss alla distanza 
necessaria.

Per impostare il Trailing Stop, trova 
la funzione pertinente nel menu 
contestuale della posizione (fai clic 
con il tasto destro del mouse nella 
scheda Operazioni (Trade).

Cos'è il Trailing Stop e come applicarlo
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MetaTrader 5 ha tutto per garantire un lavoro conveniente ed efficiente nei mercati 
finanziari. Ora sai come sfruttare le sue funzionalità. Tienilo a portata di mano per 
garantire un funzionamento regolare della tua piattaforma.  

Informativa sui rischi: 



Il trading sui mercati finanziari è altamente speculativo e rischioso. Dovresti 
mettere a rischio solo i fondi che puoi permetterti di perdere.



La performance passata performance passata non è indicativa di risultati 
futuri. Questo contenuto è fornito solo per scopi didattici e di marketing. Non è 
un consiglio di investimento. 



I CFD sono strumenti complessi e presentano un alto rischio di perdere 
rapidamente i fondi a causa della leva finanziaria. Il 71.05% dei conti degli 
investitori al dettaglio perde i fondi quando negozia CFD con questo fornitore.



Dovresti considerare se comprendi come funzionano i CFD e se puoi 
permetterti di correre il rischio elevato di perdere i tuoi fondi. 



Riassumendo
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